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https://github.com/worldbank

e Make sure you have the packages tinytex, stargazer, and huxtable installed

# Package we used for other sessions, install only 1f needed

install.packages("huxtable")

# New packages
install.packages("tinytex")
install.packages("stargazer")

# No need to load the packages for now
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Preamble @5 min)

e Use tinytex to install LaTeX with: tinytex::install_tinytex()
e This will take a while. Leave it running:

Console  Terminal Background Jobs = ]

@R R421 - ~/ e

> tinytex::install_tinytex() ‘

Found 'C:\Users\wh532468\AppData‘\Roaming\TinyTex\bin\win32\tImgr.bat"', which indicates a
LaTeX distribution may have existed in the system.

Continue the installation anyway? (Y/N) y

trying URL "https://yihui.org/tinytex/TinyTex-1.zip'

Content type 'application/octet-stream' Tength 129409680 bytes (123.4 MB)

downloaded 123.4 MB

3 File(s) copied

1 File(s) copied

Running fc-cache -v -r

I v

e LaTeX can be unpredictable in WB computers. It's possible that this didn't

work
e Don't worry for now, just follow the approppriate instructions we'll specify in

the exercises 3782



Introduction

e This is an introduction to R Markdown

o We'll show:
1. How to write and knit (output) R Markdown documents
2. How to format text and R code in R Markdown documents
3. How to include regression tables in R Markdown documents
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Dynamic documents




Dynamic documents and R Markdown

e Dynamic documents are documents that include both text and code outputs
e They are generated by a script and are updated automatically every time the

script runs
e R Markdown is a type of dynamic document
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Dynamic documents

e Code outputs and text are fully integrated

® | r-markdown-example.Rmd - (]

s Q@ @kt - - @ insert - *Run ~ %~

Document example

4

title: "Document example”
author: "Luis Eduardo San Martin"

Luis Eduardo San Martin

1/28/2022

date: "1/28/2022" e
output: pdf_document Now 11 show some cado sl
—— Sy (s mpy)

#%  Min, ist Ou. Median  Mean 3rd (u. Max,
L 10.40 15.43 19.20 20,00 2,80 33,

## My aﬂa1y515 Andl ber 1 axplatn whas | just di, all in the sarme document

This is how dynamic documents work.

4

. _
QWO Owv L wMmPE
»

Here I explain what I'11 do.

11

12 Now I'11 show some code results:

13

14~ " {r} - )

15 data(mtcars)

16 summary(mtcarsSmpg)

17~ °°°

18

19 And here I explain what I just did, all in the same script.
20

21 This is how dynamic documents work.

22
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Dynamic documents

e You can format the text and code outputs as much as you need

1.3  Figure 3. Availability of SDG gender indicators by region (N=181 countries)

B B .. N X N ~ Iacicle East & North Africa { /-qibl
## Figure 3. Availability of SDG gender indicators by region (N=181 countries) Regonal
R Lo
" fr availabilitydat} - Averogsscms ot cmites
Moo Amanicad 100 /
avail_plt_df <- read_csv(pasteO(output_dir, '/SPI_Gender_UNSD_data_5Syr.csv')) %% Suts-Sanaran Atica | &8 ¢
filter(!(iso3c %in% pop_exlude_cntry)) %%
mutate(availability=100*ind_quality) %>% #convert ind_quality measure which is 0-1 to percentage P— | hed
available by multiplying by 100
filter(date==2020 & goal=="Combined") %>% #keep just most recent year Ewrope & Cantal Asia ] 40
Teft_join(wpI_df) %>%
mutate (income_alt_groups=case_when( Soutn Asiad 20

income_level=="High income" & SP.POP.TOTL<=500000 ~ "Hgh Income & Pop <= 500K", o 1
income_level=="High income" & SP.POP.TOTL>500000 ~ "Hgh Income & Pop >= 500k", ’

1%

50 75
SDG Gender Indicator Avasabilty
TRUE ~ income_level The 25th percentie of the SDG gender avalabaey & 26% h-n-u.muam.g;fammumn

),

pop_groups=case_when( 1.4 Figure 4. Availability of SDG gender indicators by income group (N=181

SP.POP.TOTL<=500000 ~ "Pop <= 500K", countries)
SP.POP.TOTL>500000 ~ "Pop > 500K",
) )
Low meome | s
avail_plt_df %% Average scross st
write_excel_csv(pasteO(output_dir, '/SPI_Gender_availability_inc_reg_pop.csv')) R i /
" {r avail_chartl} A Uppor miccie mcoma 3
set.seed(241399)

coma bevel
average \

#calculate global average begh miama + n2
world_avg <-
avail_plt_df %%

= [ ) w0

summarise(avg = mean(availability, na.rm = T)) %% : SDG Gender Indicator Avatlability
The 25th parcentie of the SDG gender avalatdty & 26%  The mackan & 32% and tha T5th parcentie is 35%. Means are
pull(avg) e Cckes o1 HZR0 SO0ONNG 80 POPAAIOR
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Dynamic documents

e Fach document element and formatting is defined by R and Markdown code
e You can define the document type you need

YAML sets title, date,
and output type

R Markdown script

& knit - =

. Q PRun v | G v
1e|-—

2 |title: "Qutbreak Situation Report”

3 |date: "4/24/2021"

4 output: word_document

Gal -mm

6

7=/ "7 {r setup, echo=FALSE} »

8 pacman::p_load(rio, here, tidyverse, janitor, incidence2, flextable)

9 |linelist <- rio::import(here::here("data"”, "case_linelists”, "Tinelist_cleaned.rds"))

10+ """

11

12 This report is for the Incident Command team of the fictional outbreak of Ebola cases.
#*As of "r format(max(linelistSdate_hospitalisation, na.rm=T), "%d %B")  there have
been “r nrow(linelist)" cases reported as hospitalized.**

13

14 - #2 Summary table of cases by hospital

15

16~ "~ "{r, echo=F, out.height="75%"} z

17 |linelist %%

18 filter(!is.naChospital)) %%

19 group_by(hospital) %%

20 summarise({cases = n(),

21 deaths - sum(outcome "Death”, na.rm-T),

22 recovered - sum(outcome -- "Recover”, na.rm=T)) %%

23 adorn_totals() %%

24 gflextable()

257"

26

27~ &% Epidemic curve by age

28

20+ ""*{r, echo=F, warning=F, message-F, out.height = "75%", out.width="100%"} = »

30 |# create epicurve

31 | age_outbreak <- incidence(

32 Tinelist,

33 date_index - date_onset, date of onset for x-axis

34 interval "week", # weekly ag gation of cases

35 groups - age_cat)

36

7 | & plot

38 plot(age_outbreak, n_breaks - 3, fi11 - age_cat, col_pal - muted, title - "Epidemic
curve by age group™)

39-| """

40

3832 Chunk 3 & R Markdovn &

Code chunk loads
packages and data

Output (e.g. Word document)

£ search | |

Zotero

k_report - Re:

References Mailings Review View Help Picture Format

F RS PR PERE RS- RN RERY SRR FERRERRY Ry

Outbreak Situation Report
4f24/2021

This report Is for the Incident Command team of the fictional outbreak of Ebola cases. As of
30 April there have been 5888 cases reported as hospitalized.

Text and in-line code

Summary table of cases by hospital

hospaal cases  gealns  recovered
Central Hospital 454 193 165
Mintary Hospital 8% 399 309
Missing 1469 611 514
Code chunk makes table o W ows
Port Hospital 1762 785 579
St Mark's Matemity Hospital (SMIH) 422 199 126
Total AL 5888 2,582 1983

i =

#i Headlngs Epidemic curve by age
O
Epidemic curve by age group

Code chunk makes plot

O
Weekly incidence

2
g
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Why use dynamic documents?

Increased research transparency. Documents are fully reproducible

No more copying and pasting outputs from R to a document editor

Nice option for simple documents that don't require a lot of formatting, but
you can also customize your documents as needed

Can include code snippets
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Knitting R Markdown documents




Knitting R Markdown documents

R markdown combines text, R code, and rendered outputs

The text follows Markdown's syntax

The code and outputs follow R's syntax

Knitting an R Markdown document is rendering the text and code portions

Into a single output
The output can be a PDF, Word, HTML document, or others

13/ 82



Knitting R Markdown documents

Exercise 1: Knit an R Markdown document (® 2 min, leave it running)

1. Download the file r-markdown-template.Rmd from : https://osfio/7g6t9/
2. Open this file in RStudio
o If the Installation of tinytex didn't work, change line 2 to: output:
html document

3. Click on Knit. If RStudio asks you to update some packages, select Yes
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https://osf.io/7g6t9/

Knitting R Markdown documents

Note that this might take a while

Console  Terminal Render ¥  Background Jobs ey [

- | ../Downloads/r-markdown-template.Rmd

A L0 =l J [ U E =N LS ELEL YN b LEIII'..I' I L Pl e T =T LW I OaLT=A = =010 i Il P drEdl o
+autolink_bare_uris+tex_math_single_backslash --output r-markdo
wn-template.tex --lua-filter "C:\Users‘wb332468\appData’Local’Rr
“win-Tibrary' 4. 2N rmarkdown' rmarkdown® Tuapagebreak. Tua" --lTua-f
ilter "C:M\Users'wb332468%\appData’Local‘\R\win-1ibrary'4. 2\ rmarkd
own', rmarkdown, Tuat Tatex-div. Tua" --self-contained --highlight-s
tyle tango --pdf-engine pdflatex --variable graphics --wvariable
"geometry:margin=1in”
output file: r-markdown-template. knit.md

We'll continue with markdown syntax while it finishes

k
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Markdown




Markdown

rmarkdown ) M '

Code part Text part
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Markdown

e The text part of R Markdown follows the syntax of Markdown

e Markdown is a "light" markup language. It's similar to Latex or HTML, but
simpler

e Markdown was designed to be easily readable while allowing to format text
and document sections
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Markdown - Headers

e Headers in markdown are preceded by pound (#) symbols
o Additional pound symbols denote a lower level in the headers hierarchy

# This s a header This is a header
## Subheader 1
### Subheader 2 :> Subheader 1
#### Subheader 3 Subl )
ubheader 2

Subheader 3
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Markdown - Paragraphs

e Text not preceded by special symbols are regular paragraphs.

## Paragraphs

This 1s a Tine of text.
This i1s another 1line in the same paragraph.

New paragraphs are separated by two Tine breaks.

<

This is a line of text. This is another line in the same paragraph.

Paragraphs

New paragraphs are separated by two line breaks.
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Markdown - Text emphasis

e Emphasized text is enclosed by special symbols.

## Text emphasis
Text in italics goes between *asterisks® or _underscores_.
Text in bold goes between **two asterisks** or __two underscores__.

You can combine asterisks and underscores to **emphasize with italics and
bold _at the same time_**.

Strikethrough text ~~uses two tildes~~.

Text emphasis
Text in italics goes between asterisks or underscores.
Text in bold goes between two asterisks or two underscores.

You can combine asterisks and underscores to emphasize with italics and bold at the same time.

Strikethrongh text wses—+two-tildes,
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Markdown - Lists

e Markdown allows us to use both ordered and unordered lists.

## Lists

Ordered Tists:

1. Include a number and a dot before every item
2. Also remember to include a blank Tine before the beginning of the Tist

1. The actual number does not matter, the item will have the correct order
number

Lists
Ordered lists:

1. Include a number and a dot before every item
2. Also remember to include a blank line before the beginning of the list
3. The actual number does not matter, the item will have the correct order number
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Markdown - Lists

e Markdown allows us to use both ordered and unordered lists.

Unordered lists:

* You can use an asterisk
+ Or a plus symbol
- Or a minus symbol

U

Unordered lists:

e You can use an asterisk
e Or a plus symbol
e Or a minus symbol
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Markdown - Links

e \We can also include links as text in Markdown.

## Links

Include the 1ink text in brackets followed by the URL in parentheses.
Like this:

This is [the wB website] (https://https://www.worldbank.org)

Links

Include the link text in brackets followed by the URL in parentheses. Like this:

This is the WB website

:httpsu’/https://www.worldbank,org]
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Markdown - Tables

e Lastly, we can include tables in Markdown text.

## Tables

Use vertical Tlines to separate columns and at least three dashes to separate column headers.

|This is column 1|This is column 2|

|Row 1 |[Row 1 |
|Row 2 |Row 2 |
Tables

Use vertical lines to separate columns and at least three dashes to separate column headers.

This is column 1 This is column 2

Row 1 Row 1
Row 2 Row 2
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Markdown - Tables

e Lastly, we can include tables in Markdown text.

The width of the cells can vary in the markdown text and the output will look the same.

|This 1s column 1 |This is column 2|

Rt EEL LI L LI |
|Row 1 |Row 1 |

|Row 2 |Row 2|

The width of the cells can vary in the markdown text and the output will look the same.

This is column 1  This is column 2

Row 1 Row 1
Row 2 Row 2
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Exercise 1 results

o If exercise 1 worked, you'll now see this PDF file (or HTML) in the folder where
you saved r-markdown-template.Rmd

A

Name Date modified Type

Code 1/28/2022 2:51 PM File folder

DataSets 8/24/2020 3:42 PM File folder

Output 4/5/2021 4:37 PM File folder
G descriptive-statistics.R 1/13/2022 1:29 PM R File
r-markdown-template.pdf 2/1/2022 10:51 PM Adobe Acrobat Docu...
e r-markdown-template.Rmd 2/1/2022 10:36 PM RMD File

o Ifit's still running, let it run until it finishes
o If It failed, try again after changing output: html_document In line 2
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R Code
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Including R code

e R code in R Markdown goes inside fenced code blocks, as the one below

{r}

# Your R code goes here
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Including R code

e To add new block, you can type the fences directly, or go to Insert > R in the
script panel of RStudio, or type CTRL + ALT + 1

— Al QI @knit - W insert ~ 11 L PRun v | B v | =

! 8 R

Bash
D3

all

@

l Python
PP, Rcpp
¥ sa
@

Stan

1:1 (Top Level) = R Markdown =
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Including R code

Exercise 2: Include the summary of a variable (® 2 min)

1. Create a header named R Code at the bottom of r-markdown-
template.Rmd

2. Create a new fenced code block where you load the dataset mtcars
o mtcars IS a built-in dataset. Load it with: data(mtcars)

3. Inside the same block, get the summary of the variable mpg with

summary(mtcars$mpg)

4. Knit. You'll have to close the PDF document if you have it opened

31/ 82



Including R code

##t R Code

o {r}
data(mtcars)
summary(mtcarsSmpg)
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Including R code

# R code

{r}
data(mtcars)
summary (mtcars$impg)

v

R code

data(mtcars)
summary (mtcars$mpg)

H##t Min. 1st Qu. Median Mean 3rd Qu. Max.
## 10.40 15.43 19,20 20.09 22.80 33.90
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Including R code

e What about running only the code block and not knitting the document?
e You can do that with the B icon at the upper right corner of the block
e The other icon (P) will run all previous code blocks until this block

## R Code
e

data(mtcars)
summary (mtcars$mpg)

I
v
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Including R code

e Note that the output echoes both the code and the output

e What If we wanted to include the output but not the code?

e We use the argument echo = FALSE In the fenced code block for that

e Code block arguments are separated by commas inside the curly brackets, as

INn: {r, echo = FALSE}
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Including R code

Exercise 3: Omit the code when knitting R code (® 1 min)

1. Add the option echo = FALSE to the fenced code block created in
exercise 2
2. Knit the document and see how It's different now
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Including R code

“**{r, echo = FALSE}
data(mtcars)
summary(mtcarsémpg)
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Including R code

# R code

" "{r, echo = FALSE} - )
data(mtcars)
summary (mtcars$mpg)

R code

## Min. 1st Qu. Median Mean 3rd Qu. Max.
#it 10.40 15.43 19.20 20.09 22.80 33.90
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Including R code

e To include only R code but not the output, we use the option eval = FALSE

“**{r, eval = FALSE}
data(mtcars)
summary(mtcarsSmpg)
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Including R code

# R code
" {r, eval = FALSE} - )

data(mtcars)
summary (mtcars$mpg)

&

R code

data(mtcars)
summary (mtcars$mpg)
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R Plots
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Including R plots

e Adding R plots Is similar to adding R code
e Include the code producing the plot in a fenced block

e The block option echo = FALSE Is useful when we only want to include the
plot but not the code producing it
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Including R plots

Exercise 4: Include an R plot in your document (® 2 min)

1. Create a header named R Plots
2. Create a new fenced code block with the option echo = FALSE
3. Add the following code inside the new block:

plot(mtcarsSwt,
mtcarsSmpg,
main = "Plot example",
xlab = "Car weight",
ylab = "Miles per gallon")
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Including R plots

# R plots

“**{r, echo = FALSE}
plot(mtcarsSwt,
mtcarssmpg,

main "Plot example",
xlab = "Car weight",

ylab = "Miles per gallon")
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Including R plots

# R Plots
" {r, echo = FALSE} = )
plot(mtcarsiwt,

mtcars$mpg,

main = "Plot example",

xlab = "car weight",

ylab = "Miles per gallon")

R Plots : :

Plot example

o]
Q
o _| oo
(3]
g o
T Q- °
5 o
s
5 Oo (o]
o o %o o
W 8~ Q
@ g °
= ° 4
o
Lo og o o
o
o _| o 0
- T T T T
2 3 4 5
Car weight
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Including code inline

e Inline code is enclosed by backtick followed by an r (“r) and a single backtick
e For example:

The mean of mpg is “r mean(mtcarsSmpg) .

e Will be rendered as:

The mean of mpg is 20.090625.

e Note that inline code doesn't go enclosed in code blocks, it's just regular
Markdown text
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Including code inline

Exercise 5 (®2 min)

1. Create a new header named Inline code In markdown-template.Rmd
2. Add an unordered list with the following text and include inline R code
to render the corresponding numbers in each case
o The number of elements in mtcars is: (use function nrow(mtcars))
o The mean of weight is: (use function mean(mtcarsswt))
o The standard deviation is: (use function sd(mtcarsswt))
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Including code inline

# Inline code

- The number of elements in mtcars is 't nrow(mtcars)’
- The mean of weight is 'r mean(mtcarsSwt)’
- The standard deviation is 't sd(mtcarsSwt)’
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Including code inline

# Inline code

- The number of elements 1n mtcars i1s: r nrow(mtcars)
- The mean of weight is: r mean(mtcars$wt)

- The standard deviation 1is:

Inline code

‘r sd(mtcars$wt)’

e The number of elements in mtears is: 32

e The mean of weight is: 3.21725

e The standard deviation is: 0.9784574
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Including code inline

You can use the function round() to control the number of decimals displayed.

# Inline code

- The number of elements in mtcars is 't nrow(mtcars)’
- The mean of weight is 'r round(mean(mtcarsSwt), 1)°
- The standard deviation is 't round(sd(mtcars$wt), 2)°
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Including code inline

You can use the function round() to control the number of decimals displayed.

# Inline code

- The number of elements in mtcars 1is: r nrow(mtcars)
- The mean of weight is: r round(mean(mtcars$wt), 1)
- The standard deviation 1s: r round(sd(mtcarsSwt), 2)

Inline code

¢ The number of elements in mtcars is: 32
¢ The mean of weight is: 3.2
e The standard deviation is: (.98
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Including code inline

You can also combine R inline code with the markdown syntax for tables to
produce statistics tables.

# Inline code 1in tables

Column: weight| Value

N ‘r nrow(mtcars)’
Mean “r round(mean(mtcarsSwt), 1)°
SD ‘r round(sd(mtcars$wt), 2)°
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Including code inline

You can also combine R inline code with the markdown syntax for tables to
produce statistics tables.

# Inline code in tables

|[Column: weight| value |
| e cccnea- | see e e ccccccccccccccccccaa- I

[N | r nrow(mtcars) |
|Mean | r round(mean(mtcars$wt), 1) |
|sD | r round(sd(mtcarss$wt), 2) |

¢

Column: weight  Value
N 32
Mean 32
sD 0.98

Inline code in tables
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Including regression outputs

e IN a previous session, we saw that we can produce regression tables in LaTeX
e We can use code producing LaTeX outputs along with the code block option
results = "asis" to display them in the knitted document
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Including regression outputs - Stargazer

e First, we'll start with the function stargazer() from the package stargazer

e The first argument of stargazer() Is a regression result

e We also include the arguments echo = FALSE and message = FALSE In the
code block to omit printing the code and messages that appear when loading
stargazer

e In stargazer() we include header

FALSE to omit printing stargazer
metadata

Important: When using external packages in RMarkdown, you need to have them
loaded in a code block regardless of if they're already loaded in your current
session. Libraries have to load again for each knit.

57/ 82



Including regression outputs - Stargazer

“*“{r, echo = FALSE, message = FALSE, results
# Loading stargazer

library(stargazer)

# Creating a simple regression
model <- lm(mpg ~ cyl + hp, data = mtcars)

# Printing 1t with stargazer
stargazer(model, header = FALSE) # add: type

llas.i-sll

"html" 1f knitting to HTML

58/ 82



Including regression outputs - Stargazer

Table 2:

Dependent variable:

" {r, echo = FALSE, message = FALSE, results = "asis"}

mpg
#_Load1ng stargazer oyl _9 965
library(stargazer) (0.576)
# Creating a simple regression [:i) hp —0.019
model <- Im(mpg ~ cyl + hp, data = mtcars) (0.015)
# Printing it with stargazer Constant 36.908%"*
stargazer (model, header = FALSE) (2.191)
Observations 32
R? 0.741
Adjusted R? 0.723
Residual Std. Error 3.173 (df = 29)
F Statistic 41.422*** (df = 2; 29)
Note: ‘p<0.1; **p<0.05; ***p<0.01
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Including regression outputs - Stargazer

Exercise 6 (® 3 min)

1. Create a new header named Regressions - Stargazer In r-markdown-
template.Rmd

2. Add a new code block with the arguments echo = FALSE and results
"asis”

3. Load stargazer in the code block

4. Add a regression of the variable mpg on wt and hp

5. Use stargazer's arguments header = FALSE, title = "your_title" and

omit = c("Constant") to customize your table
o If your output is HTML instead of PDF, include the argument type =

"html" In stargazer|()
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Including regression outputs - Stargazer

# Regressions - Stargazer

“**{r, echo = FALSE, message = FALSE, results
library(stargazer)
model <- lm(mpg ~ wt + hp, data = mtcars)
stargazer(model,

header = FALSE,

title = "Best table ever",

omit = c("Constant"))

"asis"
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Including regression outputs - Stargazer

Table 2: Best table ever

Dependent variable:

mpg
wt —3.878***
(0.633)
hp —0.032***
(0.009)
Observations 32
R? 0.827
Adjusted R? 0.815

Residual Std. Error
F Statistic

2.593 (df = 29)
69.211°** (df = 2; 29)

Note:

*p<0.1; **p<0.05; ***p<0.01
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Including regression outputs - Huxtable

e Remember huxtable? we can also use it to include regression tables in R
Markdown

e The advantage of using huxtable compared to stargazer IS that we don't
have to define the type of output we're generating with R Markdown. huxtable
automatically detects it and will transform the output as needed in the
resulting document

e huxtable has an important disadvantage, though: it requires to install
external libraries in your local LaTeX installation
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Including regression outputs - Huxtable

e Conveniently, the library huxtable has a function that handles that
installation for us (needed only if you're knitting to PDF)

# Only 1f you're knitting to POF:
huxtable::install_latex_dependencies()

e Once this finishes, we can use huxtable with R Markdown
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Including regression outputs - Huxtable

e For regressions, we use the function huxreg() as in the example below
e Note that the option results = "asis" IS not used with huxtable

“**{r, echo = FALSE, warning = FALSE}

library(huxtable)
model <- lm(mpg ~ wt + hp, data = mtcars)

huxreg(model)
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Including regression outputs - Huxtable

e For regressions, we use the function huxreg() as in the example below
e Note that the option results = "asis" IS not used with huxtable

(1)

(Intercept) 37.227 **x*

(1.599)

"""{r, echo = FALSE, warning = FALSE} wt -3.878 ***

TibraryChuxtable)

model <- Im(mpg ~ wt + hp, data = mtcars) (0.633)

huxreg(model)

o hp -0.032 **

(0.009)

N 32
R2 0.827
logLik -74.326
AlIC 156.652

% p < 0.001; ** p < 0.01; * p < 0.05.
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Including regression outputs - Huxtable

Exercise 7: Now with Huxtable (® 2 min)

1. Create a new header named Regressions - Huxtable In r-markdown-

template.Rmd
2. Add a new code block with the argument echo = FALSE

3. Load huxtable in the code block
4. Add a regression table of the variable mpg on wt and hp using huxreg()
5. Use huxreg's argument omit_coefs = c("(Intercept)") to customize

your table
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Including regression outputs - Huxtable

# Regressions - Huxtable

““{r, echo = FALSE, warning = FALSE}

library(huxtable)
model <- lm(mpg ~ wt + hp, data = mtcars)

huxreg(model,
omit_coefs = c("(Intercept)"))
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Including regression outputs - Huxtable

wt

hp

N

R2
logLik
AIC

(1)

-3.878 *H*
(0.633)
-0.032 **

(0.009)

32

0.827

-74.326

156.652

B p < 0.001; ** p < 0.01; * p < 0.05.
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Including regression outputs - Huxtable

e If you want to include a title in your regression, use the command
set_caption() with the result of huxreg() as argument

“**{r, echo = FALSE, warning = FALSE}
library(huxtable)
library(dplyr)
model <- lm(mpg ~ wt + hp, data = mtcars)
table <- huxreg(model,

omit _coefs = c("(Intercept)"))
table %>% set_caption("Another nice table")
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Including regression outputs - Huxtable

Table 3: Another nice table

wt

hp

N
R2
logLik
AIC

(1)

-3.878 **
(0.633)
-0.032 **

(0.009)

32
0.827
-74.326

156.652
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Thank you!




Annex
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Annex - Opening a new R Markdown In R Studio

GO to File > New File > R Markdown

You can register the author name and the document title. This can be
changed later if needed

You can also define the default output format (HTML, PDF, Word). This can also
be changed later

Selecting 0K will generate a template with document sections and code
blocks that you can modify

e Selecting Create Empty Document will ignore the author, title, and output
format registered and will result in a completely blank R Markdown document
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Annex - Author, title, and output type

e The section enclosed in --- at the beginning of the document can contain

the author, title, and default output format
e You can add the author and document title with author: NAME and title:
TITLE
e You can also change the default output format. Some options are:

@)

©)

@)

output:
output:
output:
output:

html document
pdf document
word document

beamer_presentation
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Annex - Naming R code blocks

e You can name R code blocks if you add the name after the r In the initial
brackets
e The example below has the name my-r-code

Y {r my-r-code}
summary(mtcarsémpg)
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Annex - Naming R code blocks

e This Is very convenient to debug code blocks by clicking on Output under the
R Markdown tab of the console, in case your file has an error

Console  Terminal R Markdown Jobs |
@7 .. /Presentations/07-r-markdown.Rmd Output  Issues
List of 2 a

$ echo : lTogi FALSE
$ out.width: chr "75%"

| e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e | 96%
ordinary text without R code
l et it e e e et e et ae e et et e | 98%
Tabel: my-r-code
Quitting from lines 590-591 (07-r-markdown.Rmd)
Error in eval(expr, envir, enclos) : object 'country' not found
calls: <Anonymous> ... handle -> withcallingHandlers -> withvisible -> eval -> eval ~
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Annex - Including images

e The Markdown syntax to include images is: ![Image name](path/to/image)
e For example:

I [R logo](img/r-markdown/r-1logo. jpg)

e Renders:
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Annex - Including a LaTeX preamble in a PDF doc

e If you want to further customize a PDF document in R Markdown and you're
familiar with LaTeX, you can include a LaTeX preamble that will be executed
when you knit your document

e To enable this feature, replace output: pdf_document with the following code
in the section enclosed by the three dashes (---) at the beginning of your
document

output:
pdf document:

includes:
in_header: "preamble.tex"
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Annex - Complete regression table using Stargazer

***{r, echo = FALSE, message = FALSE, results = "asis"
library(stargazer) Table 1: Best table ever
regl <- lm(mpg ~ wt + hp, data = mtcars) _ _ _
Miles per Gallon 1/4 Mile Time
reg2 <- lm(mpg ~ wt + hp + factor(gear), data = mtcars)
reg3 <- lm(gsec ~ wt + hp, data = mtcars) (1) (2) (3) (4)
regh <- lm(gsec ~ wt + hp + factor(gear), data = mtcars) Weight —3.878"*  —3.2397 0.942%*~ 0.747*
(0.633) (0.878) (0.266) (0.371)
stargazer(regl,
reg? Horsepower —0.032*** —0.035*** —0.027*** —0.0237**
' (0.009) (0.013) (0.004) (0.005)
regl,
L
rl::'g s . N Gears FE No Yes No Yes
title = "Best table ever”, Observations 32 32 32 32
keep = c('wt', 'hp'), Adjusted R? 0.815 0.811 0.628 0.616
covariate.labels = c('Weight', Note- p<0.1: *p<0.05; *Fp<0.01

‘Horsepower'), Standard errors in parentheses
dep.var.labels = c('Miles per Gallon',
'1/4 Mile Time'),
dep.var.caption = '',
add.lines = list(c('N Gears FE', 'No', 'Yes', 'No', 'Yes')),
keep.stat = c('n', 'adj.rsq'),
header = FALSE,

notes = 'Standard errors in parentheses')
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Annex - Complete regression table using Stargazer

Table 1: Best table ever

Miles per Gallon 1/4 Mile Time
(1) (2) (3) (4)
Weight —3.878*  —3.239"** 0.942*** 0.747*
(0.633) (0.878) (0.266) (0.371)
Horsepower —0.032*** —0.035%** —0.027*** —0.023***
(0.009) (0.013) (0.004) (0.005)
N Gears FE No Yes No Yes
Observations 32 32 32 32
Adjusted R? 0.815 0.811 0.628 0.616
Note: *p<0.1; **p<0.05; ***p<0.01

Standard errors in parentheses
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Annex - Looking ahead

e Markdown guide

R Markdown: The Definitive Guide
An Iintroduction to Stata Markdown
Stargazer official manual
Introduction to Huxtable
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https://www.markdownguide.org/
https://bookdown.org/yihui/rmarkdown/basics.html
https://osf.io/nam2d/
https://cran.r-project.org/web/packages/stargazer/stargazer.pdf
https://cran.r-project.org/web/packages/huxtable/vignettes/huxtable.html

